Lecture Manuscript Guidelines

These formatting guidelines apply to manuscripts being submitted for lectures only, NOT for limited enrollment sessions (LES), laboratories or multidisciplinary reviews (MDR.) Refer to separate instructions for those sessions distributed by Kelli Albarado (contact: kelli@veccs.org).

Manuscript Submission Deadline:
Manuscripts must be uploaded to the online submission site by July 1, 2017. Manuscripts submitted beyond the deadline will not be included in the Conference Proceedings. You will receive an email invitation with instructions on how to upload your manuscript. If you misplace that email, contact the proceedings editor at hishenandoah@gmail.com for a copy.

General Manuscript Guidelines:

- The content of each manuscript should closely reflect the content of the lecture presentation. Your manuscript will be used by attendees as a means to decide which lectures to attend, as a means of preparation before attending lecture, and as a useful reference after the conference. Manuscripts will be made available to attendees online before the symposium, and will remain archived online for future reference.

- Each lecture is assigned a lecture presentation level corresponding to its intended audience at the symposium. Your lecture and manuscript material should be prepared according to their intended level. Refer to your Speaker Confirmation Agreement, your emailed manuscript submission invitation, or the online manuscript submission site to confirm the designated lecture presentation level of your lecture/manuscript. A detailed explanation of each level presented on page 8 of these Guidelines.

- Each manuscript should be roughly 3-4 single sided pages in length per one hour of lecture, including references. A rough estimate is 1 page per 15 minutes of lecture.

- Manuscripts must use paragraph narrative format only. Outlines, bulleted manuscripts or Power Point slides will not be accepted.

- Manuscripts will be returned for proper formatting of references if submitted in any other format/style, and will be returned for correction if excessive spelling and grammatical errors exist; please utilize spellcheck and grammar check before document submission.

- Previously copyrighted material (or material adapted from copyrighted works), such as text, images, diagrams, charts, etc., must be accompanied by a written letter of permission from the author and the copyright holder/publisher. The permission process may take 4-8 weeks, and any fees associated with obtaining permission are the responsibility of the author. Written letters of permission should be forwarded to the proceedings editor. VECCS reserves the right to return manuscripts to the author for removal of previously copyrighted material if written permission has not been submitted.

- Co-authors may either submit their individual manuscript contributions directly through the online site or incorporate their contributions into one single manuscript document. If a single document will be submitted, the primary author must contact hishenandoah@gmail.com to ensure proper acknowledgement of each co-author’s work.

VECCS and the conference attendees greatly appreciate your contribution to these proceedings and to the success of IVECCS 2017.
Specific Manuscript Instructions: Refer to “Example Manuscript” on page 6 for a properly formatted manuscript; detailed instructions follow:

Formatting:

Refer to “Document Formatting Tips” on page 7 for step-by-step instructions on formatting these options in Microsoft Word® version 2010; other versions will vary slightly.

Page numbering: Pages should not be numbered.

Page size: Page Size should be 8.5" X 11" (Letter Size).

Margins: Set the top, left, and right margins at 0.9 inches and the bottom margin at 1.2 inches.

Line Spacing: Set the "line spacing" to single spacing. Set the spacing "before" and "after" each line to zero.

Tabs: Set the tab position to 0.5 inches (the text of each new paragraph will begin at 0.5 inches from the margin.)

Justification: Use full justification so that the text is flush with the left and right margins.

Font (Typeface): Set the font to Calibri.

Font Size: Use size 10 point throughout the document, but note that 14 point and 12 point are used in the document heading only.

Font style: Set the font style to regular, with bold, italicized, and underlined font styles as needed throughout the document.

Document Text:

Title/author/affiliation:

On the first line, centered, in bold, ALL-CAPITALS, 14 point Calibri font, enter the presentation title EXACT as it is listed in your Speaker Confirmation Agreement. The IVECCS scientific program schedule will use this exact same title. Contact the proceedings editor immediately if you strongly believe that the title of your lecture does not reflect the content of your presentation/manuscript; any requests for modification will be forwarded to the Program Coordinator for consideration.

On the second line, centered, regular text (not bold, italicized or underlined), upper and lowercase, 12 point Calibri font, enter your name, professional degree(s), and Diplomate status, if applicable, exactly as you wish for this information to appear in the proceedings.

On the third line, in upper and lowercase, regular text, 12 point Calibri font, enter your hospital or organization’s affiliation, then a comma, then your location city, then comma, then your state abbreviation. If you are outside of the United States, add another comma and list your country. If there are multiple authors contributing to the same document, enter each author's information as above, skipping one blank 12 point line in between each author, and have the primary author contact the proceedings coordinator in advance of submission to ensure all authors’ individual contributions are properly acknowledged.

After the title/author/affiliation is entered, the entire manuscript will use 10 point Calibri font (regular, not bolded).
Headings/Subheadings:

Avoid unnecessary subheadings such as "Introduction" or "Conclusions". If headings are absolutely necessary for the organization of the manuscript, leave one blank 10 point line above each heading, begin along the left margin (do not indent), and type the heading in bold upper and lowercase letters.

On the next line down, indent 0.5 inches and begin text (do not leave a blank line between heading and the next line’s text) in italicized, upper and lowercase letters followed by a colon. Leave one blank space (remain on the same row) then begin text (the sub-heading should begin the first line of a new paragraph.) Do not use automatic outline formatting, bulleting or numbering to organize your document’s text. Enter your headings/subheadings as needed, or simply use paragraph narrative form. Documents using auto outline, bulleting or numbering systems for the body of the document will be returned to the author for revision.

Units of Measure:

Temperature should be reported in Celsius followed by Fahrenheit equivalents in parentheses; example: 104°F (40°C). All measurements should be reported in metric units. Because there is a significant international review of our Proceedings, laboratory values must be reported in Système Internationale units (SI) followed in parentheses by conventional (US) units; example: BUN 67mmol/L (188mg/dL).


Referenced Drugs/equipment:

Specific drugs or equipment quoted within the text should be accompanied by generic name, dosage instructions, and manufacturer information (company name, location). Use this format throughout the text, where ever possible, rather than using footnotes.

Use of Figures/Images/Graphics/Tables:

Figures/Images/Graphics/Tables should be incorporated into the text and inserted within the body of the manuscript. Figures can be schematic or line drawings that reproduce clearly. For captions, enter the appropriate word (Table/Image/Figure/Graph) and number in bold, then a colon, then the caption text in regular (not bold) upper and lower case, then period. Example: Table 1: List of Analgesic Drugs to Use in the Critically Ill Small Animal Patient. Submit written letters of permission to publish previously copyrighted material directly to the proceedings editor (see page 1 for additional details).

Hyperlinks:

We will make every effort to keep hyperlinks active during the editing process. Be sure you have tested each hyperlink within your document for accuracy. It is ideal to cut/paste the address directly from your browser into your document while viewing the active web page to which you would like to direct your readers, to ensure the link is functional and not truncated.
References:

List at least 10 references per manuscript. The references are provided as general references and resources, and do not need to be footnoted/referenced throughout the manuscript text, but may be if you prefer. Authors are responsible for the accuracy and completeness of the references. At this time, we are unable to reserve more than 3-4 pages total space per 1 hour of lecture time for each proceedings manuscript; be sure to leave sufficient space for references while creating the manuscript.

References should appear at the end of the manuscript after the body of text. Leave one blank 10 point line between your last line of text, then type “References:” in bold upper and lowercase letters. Then begin entering the references (regular type, not bold) on the very next line along the left margin (do not indent).

Do not number each reference unless you are footnoting/referencing throughout the document. If referencing throughout the document, number these references by entering the number, then a period, single space, then enter the reference).

Do not leave any blank lines in between references.

Each and every author must be listed if there are four or less authors. References with five or more authors may include the name of the first three authors followed by “, et al.”

Page numbers must be included with each reference.

Search http://www.ncbi.nlm.nih.gov/nlmcatalog/journals or refer to the “Commonly Referenced Journal Abbreviations” document on pages 9-12 of these Guidelines to find the correct abbreviation (“NLM Title Abbreviation”) for scientific journal references.

Reference listings should use the Vancouver system. If using reference managing software, such as Endnote, disable macros so that references are no longer linked with the author’s reference libraries.

Reference examples:

Journal Article Citation (must include page numbers)

Journal Abstract (must include page numbers)

Authored Book Chapter (must include chapter author(s) and book editor(s) and page numbers)

Conference Proceedings (must include page numbers and city and year of conference)
Keywords:

Choose 5 keywords or short phrases to allow attendees to search for your manuscript using the Flash drive keyword search function or the comprehensive alphabetized keyword index within the hard copy of the Proceedings. List these keywords at the very end of the manuscript: Leave a blank 10 point line under the last reference, then along the left margin, type “Keywords:” (bold, include colon, then leave one blank space), then enter the words in alphabetical order, separated by commas, in lower-case regular font (capitalize proper names like Doppler or Starling's Law or acronyms such as GDV, GFR, ARDS, etc.) When you are prompted to enter each keyword into the online collection system, add them in all lower case except for proper names and acronyms, as above.

Spellcheck/Grammar Check:

Be sure to spell check and grammar check your document prior to submission, as manuscripts with multiple spelling/grammar errors will be returned for correction and resubmission without further review.

Proceedings Editor and Technical Support Contact Information:

For all questions relating to manuscript preparation, contact the proceedings editor, Shenandoah Diehl, at hishenoandoah@gmail.com or 949-433-0510.

If you have technical questions regarding logging in to the website, or the submission of your manuscript once logged into the web site, contact Omnipress by using the Support form link near the upper right of the online site.
EXAMPLE MANUSCRIPT - MANUSCRIPT TITLE HERE (14pt bold title)
First, Last, DVM, DACVECC (12 pt name, credentials, not bolded)
Hospital, City, ST (affiliation & city/state, not address)
BLANK 12 POINT LINE HERE (Leave one 12 point blank line under the affiliation and city/state)
First line of text if you are not using headings. Just indent this first line of your first paragraph and begin the manuscript text (the left margin is set at 0.9” and using “full justification” so that the text is flush in both the left and right margins.)

Heading of Your First Paragraph (if you choose to use headings)
Be sure the use headings only when absolutely necessary, and keep the headings very brief. When headings are used, leave one blank line above the heading. The heading should be flush with the left margin and in Upper and lowercase bold text. Do not leave a blank line below the heading, but be sure to indent the first line of text 0.5 inches before beginning text entry.
Sub-heading: Indent any subheading 0.5 inches inch and italicize the print. Use a colon after the subheading (also in italics), then start text after one blank space following the colon. The text following the sub-heading should be standard (non-italicized.)
Note that each subsequent paragraph of text is indented 0.5 inches, but does not have a blank line above it. Only when you begin a new heading should you leave a blank line between two paragraphs. Continue entry of text in this fashion until the very end of the document where references appear.
When inserting figures/images/graphics/tables, refer to detailed instructions above.

References: (note: minimum of 10 references required)
Quantz JE, Miles MS, Reed AL, White GA. Elevation of alanine transaminase and gallbladder wall abnormalities as biomarkers of anaphylaxis in canine hypersensitivity patients. J Vet Emerg Crit Care (San Antonio) 2009;10(6):536-544. (note: this is a journal citation)
Lisciandro GR. Alanine aminotransferase level (ALT) as a marker for hemoabdomen detected by abdominal FAST (AFAST) in dogs with automobile trauma. J Vet Emerg Crit Care (San Antonio) 2014 [Abstract];24(S1):S11. (note: this is a journal abstract)
Dowers K, Bright JM. Anti-aggregatory effects of GP IIa/IIIb antagonist on feline platelet function. In: Proceedings of the American College of Veterinary Internal Medicine; 2000: Chicago. pp. 712. (note: this is a proceedings manuscript citation)

-Note about references: One blank line appears between the end of your manuscript text and the bold upper and lowercase heading “References” - otherwise, no blank lines should appear in the references section. References are NOT numbered (unless you are footnoting/referencing throughout the manuscript text (not required, but optional).

References submitted with incorrect or incomplete formatting will be returned to the author for editing/resubmission – this includes omission of complete author names (must list each unless 5 or more authors, then only the first 3 and ‘et al’); journal issue year, volume numbers, and page numbers required.

Keywords: congestive heart failure or CHF, diuretics, ECG, Starling's forces, ventilation
(note: list keywords in alphabetical order, all lower case except acronyms or proper names)
 DOCUMENT FORMATTING TIPS FOR MICROSOFT WORD® VERSION 2010  
(OTHER VERSIONS WILL VARY SLIGHTLY)

How to Set Margins: Set the top, left, and right margins at 0.9 inches and the bottom margin at 1.2 inches:
To do this, before typing your document text, open the "Page Layout" tab, select the "Margins" drop-down menu, then select "Custom Margins" and set the top, left, and right margins at 0.9 inches and the bottom margin at 1.2 inches (leave 'gutter' at 'zero' inches in the 'left' position), then hit "Okay."

How to Set Line Spacing: Set the "line spacing" to single spacing AND the spacing "before" and "after" each line to zero.
To do this, before typing your document text, open the "Home" tab, then in the Paragraph menu, select "Line and Paragraph Spacing" then choose “Line Spacing Options” (or just open the “Paragraph dialog box” icon in the lower right corner of the Paragraph menu). then on the "Indents and Spacing" tab, locate the "Line and Spacing" section. First, set "Spacing" both before and after each line to "0 pt" then set "Line Spacing" to "Single", then hit "Okay."

How to Set Tabs: Set the tab position to 0.5 inches (the text of each new paragraph will begin at 0.5 inches from the margin.)
To do this, before typing your document text, open the "Page Layout" tab, then in the Paragraph menu, locate the “Indent” tab and set “Left” to 0.5” and leave “Right” at zero.

How to Set Justification: Use full justification so that the text is flush with the left and right margins.
To do this, before typing your document text, open the "Home" tab, then in the Paragraph menu click “Center Text.”

How to Set Font (Typeface): Set the font to Calibri.
To do this, before typing your document text, open the “Home” tab, then in the Font menu, select "Calibri " for Font face.

How to Set Font Size: Use size 10 point throughout the document, but 14 point and 12 point are used in the document heading only (see below). Bold, Italic and Underline will be used where indicated.
To do this, before typing your document text, open the “Home” tab, then in the Font menu, either type in the number of the font size you wish to select (example: 10, 12, or 14), or use the drop-down menu to the right of the current font side displayed, and select your desired font size, then begin typing. You may alternatively type the entire document in 10 point and change the font size of the document heading information after text is typed by highlighting the desired text and then performing these functions above to change the size.

How to Set Font Style:
To do this, before typing your document text, open the “Home” tab, then in the Font menu, click the “Bold”, “Italic” and/or “Underline” buttons as needed throughout the document (either click the button then enter text, or highlight pre-typed text then click the desired button.
Veterinarian:

**ER Fundamentals:** Target audience includes new graduates and/or clinicians new to emergency medicine. These talks should be very clinical and practical in nature with a focus on core concepts.

**General:** Target audience includes general practitioners with a wide range of backgrounds that may or may not include emergency medicine. These talks should be clinical and practical in nature and aim to provide a thorough review of the topic. These may serve as “refresher” courses with updated information for the ER clinician.

**VECCSpert:** Target audience includes clinicians with a strong interest and experience in emergency and critical care medicine. Although these talks should have a strong clinical focus, they should also include pathophysiology of disease and some newer aspects of diagnostic and therapeutic management. These sessions may be of great interest to new residents seeking to understand how physiology and pathophysiology apply to the clinical treatment of emergency and critical care patients.

**Specialist:** Target audience includes specialists in veterinary medicine including, but not limited to, ACVECC Diplomates. Talks should have clinical relevance but also include a strong basis of pathophysiology and current management concepts, possible future directions and an emphasis on evidence-based recommendations.

**State-of-the-art:** These talks are intended to be a high level review of a topic that is complex or cutting-edge in nature. They are expected to heavily emphasize pathophysiology and current research.

**Core Concepts:** These sessions are designed to provide an in-depth review of the underlying physiology and pathophysiology of selected organ systems and disease states relevant to the care and management of critically ill patients. They are ideal for the resident in training, mentors of residents in training and individuals with a strong interest in the science behind emergency and critical care medicine. Topics are aimed to be applicable to both large animal and small animal clinicians.

**Resident Focus:** These sessions are aimed at residents in training, but open to all attendees. They are intended to cover narrow topics in the level of detail that would be required of a resident preparing to sit the board certification examination.

**Multidisciplinary Review (MDR):** ACVECC developed this review course to be designed for the resident in training and to review both normal physiology and pathophysiology of disease. These lectures are ideal for the future and current resident, resident mentors and those clinicians looking for a more in-depth exploration of emergency and critical care topics. The topics presented in this session are relevant to both small and large animal clinicians where possible.

**Technician:**

**General:** Target audience includes technicians in general practice with a wide range of backgrounds that may or may not include emergency medicine. These talks should be clinical and practical in nature and aim to provide a thorough review of the topic. These may serve as “refresher” courses with updated information for the ER technician.

**Advanced:** Target audience is technicians with a strong interest and experience in emergency and critical care medicine including VTS attendees. Those preparing for or thinking about VTS certification would benefit from these lectures. These talks should have a strong clinical focus covering current management concepts, but should also include pathophysiology of disease and offer possible future diagnostic and therapeutic directions with an emphasis on evidence-based recommendations.

**Specialist (previously AVECCT/AVTA):** Target audience is VTS attendees as well as non-specialized technicians with a strong interest in bringing patient management up to a specialist level. Goal is to present lectures with a strong clinical focus at the specialist level, including relevant physiology, pathophysiology, including upcoming/newer management options using evidenced-based recommendations.

**Multidisciplinary Review (MDR):** AVECC developed this full day advanced lecture series to provide an in-depth review of physiology, pathophysiology, and pharmacology of selected organ systems and diseases along with nursing care and management of critical patients. Attendees can elect to participate in the full day or half day.
COMMONLY REFERENCED JOURNAL ABBREVIATIONS

For your convenience, the journal list below includes the National Library of Medicine (NLM) abbreviations for journals which have been referenced frequently throughout previous IVECCS Proceedings.


American Journal of Veterinary Medicine
   Am J Vet Med
American Journal of Veterinary Research
   Am J Vet Res
Animal Reproduction Science
   Anim Reprod Sci
Animal Science Journal
   Anim Sci J
Avian Diseases
   Avian Dis
Avian Pathology
   Avian Pathol
British Poultry Science
   Br Poult Sc
The British Veterinary Journal
   Br Vet J
Canadian Journal of Veterinary Research
   Can J Vet Res
The Canadian Veterinary Journal
   Can Vet J
Clinical Techniques in Small Animal Practice
   Clin Tech Small Anim Pract
Comparative Immunology, Microbiology and Infectious Diseases
   Comp Immunol Microbiol Infect Dis
Compendium on Continuing Education for the Practicing Veterinarian
   Compend Contin Educ Vet
Contemporary Topics in Laboratory Animal Science
   Contemp Top Lab Anim Sci
Critical Care
   Crit Care
Critical Care Clinics
   Crit Care Clin
Critical Care Medicine
   Crit Care Med
Domestic Animal Endocrinology
   Domest Anim Endocrinol
Equine Veterinary Journal
   Equine Vet J
Equine Veterinary Journal Supplement
   Equine Vet J Suppl
International Journal of Veterinary Science and Medicine
   Int J Vet Sci Med
The Japanese Journal of Veterinary Research
<table>
<thead>
<tr>
<th>Journal Name</th>
<th>Abbreviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Journal of the American Animal Hospital Association</td>
<td>J Am Anim Hosp Assoc</td>
</tr>
<tr>
<td>Journal of the American Veterinary Medical Association</td>
<td>J Am Vet Med Assoc</td>
</tr>
<tr>
<td>Journal of Animal Breeding and Genetics</td>
<td>J Anim Breed Genet</td>
</tr>
<tr>
<td>Journal of Animal Science</td>
<td>J Anim Sci</td>
</tr>
<tr>
<td>Journal of Applied Animal Welfare Science</td>
<td>J Appl Anim Welf Sci</td>
</tr>
<tr>
<td>Journal of Aquatic Animal Health</td>
<td>J Aquat Anim Health</td>
</tr>
<tr>
<td>Journal of Comparative Pathology</td>
<td>J Comp Pathol</td>
</tr>
<tr>
<td>Journal of Dairy Science</td>
<td>J Dairy Sci</td>
</tr>
<tr>
<td>Journal of Experimental Animal Science</td>
<td>J Exp Anim Sci</td>
</tr>
<tr>
<td>Journal of Feline Medicine and Surgery</td>
<td>J Fel Med Surg</td>
</tr>
<tr>
<td>The Journal of Small Animal Practice</td>
<td>J Small Anim Pract</td>
</tr>
<tr>
<td>The Journal of Trauma and Acute Care Surgery</td>
<td>J Trauma Acute Care Surg</td>
</tr>
<tr>
<td>Journal of Veterinary Behavior</td>
<td>J Vet Behav</td>
</tr>
<tr>
<td>Journal of Veterinary Cardiology</td>
<td>J Vet Cardiol</td>
</tr>
<tr>
<td>Journal of Veterinary Dentistry</td>
<td>J Vet Dent</td>
</tr>
<tr>
<td>Journal of Veterinary Diagnostic Investigation</td>
<td>J Vet Diagn Invest</td>
</tr>
<tr>
<td>Journal of Veterinary Emergency and Critical Care</td>
<td>J Vet Emerg Crit Care (San Antonio)</td>
</tr>
<tr>
<td>Journal Veterinary Internal Medicine</td>
<td>J Vet Intern Med</td>
</tr>
<tr>
<td>Journal Veterinary Medical Education</td>
<td>J Vet Med Educ</td>
</tr>
<tr>
<td>Journal Veterinary Medical Science</td>
<td>J Vet Med Sci</td>
</tr>
</tbody>
</table>
Journal Veterinary Pharmacology and Therapeutics
   J Vet Pharmacol Ther
Journal of Veterinary Science
   J Vet Sci
Journal of Wildlife Diseases
   J Wildl Dis
Journal of Zoo and Wildlife Medicine
   J Zoo Wildl Med
Laboratory Animal Care
   Lab Anim Care
Laboratory Animal Science
   Lab Anim Sci
New England Journal of Medicine
   New Engl J Med
Open Journal of Veterinary Medicine
   Use full title (not indexed for MEDLINE)
Online Journal of Veterinary Research
   Online J Vet Res
Open Veterinary Journal
   Use full title (not indexed for MEDLINE)
Preventive Veterinary Medicine
   Prev Vet Med
Poultry Science
   Poult Sci
Reproduction in Domestic Animals
   Reprod Domest Anim
Research in Veterinary Science
   Res Vet Sci
Seminars in Veterinary Medicine and Surgery (Small Animal)
   Semin Vet Med Surg (Small Anim)
Theriogenology
   Theriogenology
Veterinary Anaesthesia and Analgesia
   Vet Anaesth Analg
Veterinary Clinical Pathology
   Vet Clin Pathol
Veterinary Clinics of North America-Equine Practice
   Vet Clin N Am Equine Pract
Veterinary Clinics of North America-Exotic Animal Practice
   Vet Clin North Am Exot Anim Pract
Veterinary Clinics of North America-Animal Practice
   Vet Clin North Am Food Anim Pract
Veterinary Clinics of North America-Large Animal Practice
   Vet Clin North Am Large Anim Pract
Veterinary Clinics of North America-Small Animal Practice
   Vet Clin North Am Small Anim Pract
Veterinary and Comparative Oncology
   Vet Comp Oncol
Veterinary and Comparative Ophthalmology
   Vet Comp Ophthalmol
Veterinary and Comparative Orthopaedics and Traumatology
   Vet Comp Orthop Traumatol
Veterinary Dermatology
   Vet Dermatol
Veterinary Economics
   Vet Econ
Veterinary and Human Toxicology
   Vet Hum Toxicol
Veterinary Immunology Immunopathology
   Vet Immunol Immunopathol
Veterinary Medical Review
   Vet Med Rev
Veterinary Medicine
   Vet Med
Veterinary Medicine International
   Vet Med Int
Veterinary Medicine and Small Animal Clinician
   VET MED SM ANIM CLIN
Veterinary Microbiology
   Vet Microbiol
Veterinary Ophthalmology
   Vet Ophthamol
Veterinary Parasitology J
   Vet Parasitol
Veterinary Pathology
   Vet Pathol
Veterinary Pathology Supplement
   Vet Pathol Suppl
Veterinary Practice Staff
   Vet Pract Staff
The Veterinary Quarterly
   Vet Q
Veterinary Record
   Vet J
Veterinary Radiology
   Vet Radiology
Veterinary Radiology and Ultrasound
   Vet Radiol Ultrasound
Veterinary Record
   Vet Rec
Veterinary Research
   Vet Res
Veterinary Research Communications
   Vet Res Commun
Veterinary Surgery
   Vet Surg
Veterinary Technician
   Vet Tech
Veterinary Therapeutics: Research in Applied Veterinary Medicine
   Vet Ther